
Travel ManagerTravel Manager
CompleteComplete

Version 7.0
US Department of
Transportation /
Federal Aviation
Administration

Information Technology
Division, ANM-60
FAA Northwest
Mountain Region
(425) 227-2060
Second Edition



Travel Manager Complete2



Contents

Travel Manager Complete 3

ContentsContents

Getting Started _____________________________ 4

Launching Travel Manager___________________ 4

Travel Terminology__________________________ 5

Creating a New Travel Voucher ________________ 6
1. Create the voucher file. _____________________6
2. Itinerary ________________________________6
3. Ticketed Transportation _____________________9
4. Expenses ______________________________10
5. Lodging/M&IE ___________________________11
6. Accounting _____________________________13
7. Comments _____________________________15
8. Totals _________________________________16

Creating a New Travel Authorization (Travel Orders)18
1. Create the authorization file. _________________18
6. Special Authorizations _____________________19
9. Totals _________________________________20

Creating a New Local Voucher ________________ 22
1. Create the local voucher file. ________________22
2. Expenses ______________________________22

Electronic Processing _______________________ 25

Process Overview and Comparison ___________ 25

Electronic Signature and Routing _____________ 26

Saving and Printing Your Documents ___________ 28

Browsing Per Diem Rates ____________________ 30

Guide to Toolbar and Menus - Document Preparation
Module __________________________________ 32

The File Menu and Matching Toolbar Buttons ____ 32

The Document Menu ______________________ 33

The Rates Menu _________________________ 34

The Reports Menu________________________ 34

The Setup Menu _________________________ 38

The Utilities Menu ________________________ 38

The Modules Menu _______________________ 38

The Help Menu __________________________ 39

Function Keys and Keystrokes ________________ 40

The Cost Options Utility______________________ 41

When Travel Manager Crashes________________ 42

Numbering Memo __________________________ 43

Travel Document Number Structure and NATS ____ 44

Addendum to Numbering Memo _______________ 46

COURSE EVALUATION ______________________ 47

TRAVEL MANAGER COMPLETE is a guide for federal government travelers and document preparers using Travel Manager software ver-
sion 7.0. This document was created in-house by FAA employees. To order additional copies of this manual, call the Northwest Mountain
Region Information Technology Division at (425) 227-2060 or consult the downloading information in the next paragraph below.

ON THE WEB: An online copy of this manual appears on the Northwest Mountain Region's Intranet, part of the FAA's Internal Web. If your
PC is configured to access the FAA's Internal Web, point your browser to www.anm.faa.gov. For downloading the entire book in Micro-
soft Word format (about 6.2MB) point your browser to ftp.anm.faa.gov/trvlmgr.

ON-SITE TRAINING: This document is also the textbook for a one-day comprehensive class for users of Travel Manager 7.0. The North-
west Mountain Region Information Technology Division will come to your region to conduct this hands-on class at any facility. For more
information, call (425) 227-2060.

NEED HELP? Travel Manager users and students can receive no-charge technical support by calling Northwest Mountain Region Infor-
mation Technology Division at (425) 227-2060.

Acknowledgements: Selected portions of this document were contributed by and are reprinted with permission from Gelco Government
Network GSD, Inc. and the US Department of Energy.

Note: Although the screen graphics contained in this manual depict Travel Manager used in the Microsoft Windows 98 operating system,
the application also performs regularly under both Windows version 3.1 and Windows 95 with little change in appearance.
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Getting StartedGetting Started

Travel Manager is designed to simplify travel processing and procedures and is customized to comply with FAA-specific travel
regulations. Pop-up menus and online instructional information guide you through the easy-to-use, personal computer-based system.

Travel Manager provides you with:

q Automated travel authorization and travel voucher processing
q Automated data access and retrieval
q System-generated travel authorization and travel voucher forms
q Online availability of up-to-date per diem rates
q Cost estimates
q Calculation of advance authorized and per diem location allowances
q An accounting system interface
q Capability to process documents with electronic signatures
q Automatic document routing, tracking, and auditing capabilities

Launching Travel Manager

Windows 95 and Windows 98: Click the Start Button and drag your mouse pointer to the Programs menu. Then move the pointer to the
Travel Manager submenu and single-click the shortcut named Travel Manager 7.0 Doc Prep.

Windows 3.1: Double-click the Travel Manager 7.0 Doc Prep icon in the Travel Manager program group, in your Program Manager
window.

First-Time Logon

If you are accessing the software for the first time, you will be prompted to create a password. In the Userid field of the logon screen,
type your assigned userid and press [Tab]. Your userid is assigned to you by your Travel Manager System Manager. Leave the Password
field blank and press [Enter]. A pop up warning box appears, indicating, "Your password is currently blank; please enter a new password
now." Click on OK. You are prompted to enter a new password.  Type a password and press [Tab]. Type the password again for
verification and press [Enter], or click on OK.

Subsequent Logons

In the Userid field of the logon screen, type your assigned userid and press [Tab]. At the Password field, type your password and press
[Enter], or click on OK. If you forget your password, contact the Travel Manager System Administrator for your organization. It will be
reset to “blank” for your next logon (see above).

From this point, refer to the various lessons in this textbook for document preparation or using the Travel Manager menus and toolbar.
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Travel TerminologyTravel Terminology

Authorization
A temporary duty travel authorization or request used to authorize travel. Travel Manager uses the information entered to estimate the cost
of travel and the amount of cash advance that should be permitted. A cash advance request form may be prepared as part of the authori-
zation.

Voucher
A temporary duty travel reimbursement voucher. Completed when travel has concluded, a voucher is used to claim reimbursement for
various travel expenses. When this document type is selected, a blank voucher screen appears, and the voucher may be completed from
scratch. It is not necessary to have entered an authorization in order to prepare a voucher.

Trip
All travel from the time the traveler leaves the residence or present duty location until the time of return. A trip may include any number of
stops at various temporary duty locations. Up to three trips may be entered on one voucher.

Voucher from Authorization
A voucher created from an existing travel authorization. Travel Manager reduces redundant data entry by allowing the generation of a TDY
voucher from an authorization. When this type of document is chosen, you will be presented with a list of travelers who have entered
authorizations in the Travel Manager database. Select a traveler and existing authorization and Travel Manager will create a voucher from
the information in that authorization. To complete the voucher fill in any details that were not  available in the authorization, such as de-
parture and arrival times, lodging costs and other miscellaneous expenses.

Local Voucher
A document used to claim reimbursement for miscellaneous expenses incurred by a government employee. Local vouchers do not in-
clude per diem allowances and are normally associated with the SF1164 form.

TDY
The abbreviation for temporary duty location.

Per Diem
The maximum amount of dollars allowed for lodging, meals and incidental expenses for one day.

M&IE
The abbreviation for meals and incidental expenses.

Leg
A portion of a trip denoting the departure from the originating location to the arrival at the destination location.

CONUS
Literally, Continental United States. Also refers to the standard per diem rate for miscellaneous and incidental expenses within the
Continental United States.

OCONUS
Literally, Outside the Continental United States. Also refers to the standard per diem rate for miscellaneous and incidental expenses
outside of the Continental United States.
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Creating a New Travel VoucherCreating a New Travel Voucher

1. Create the voucher file.

1A. From the File menu, select New. From the submenu, select
Voucher.

The File menu and the New submenu.

1B. An Untitled voucher window appears. Enter the
traveler’s SSN and press [Tab].

1C. If this traveler is not in the Travel Manager database,
contact the Travel Manager System Administrator for
your organization.

1D. Enter the Authorization Number in its field at the
upper right portion of the Untitled voucher window.

New window for an untitled voucher.

2. Itinerary

2A. To enter the itinerary information, select the Itinerary button. The Itinerary window appears. Complete each field
by typing entries or selecting from the drop-down lists. You can advance through the fields using your [Tab] key.

The Itinerary window.
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2B. EXPLANATION OF ITINERARY WINDOW FIELDS:

Date: The date when the authorization was created.

Purpose: Select the purpose of the trip from the drop-down list.

Type: Select the trip type from the drop-down list. The trip type determines how Travel Manager calculates allowances for M&IE and
lodging. The trip types listed below are standard types available.

Single Trip—Includes all travel from the time the traveler leaves home and/or present duty location until the traveler returns. It may
include travel to several temporary duty locations, but the traveler can only return home or to the present duty location once. M&IE
is automatically calculated based on the number of days at each duty location.

LOA (Cost)—A Limited Open Authorization, also known as an Open or Blanket Travel Order. This is an authorization for a certain
period of time. It may cover any number of trips to or from the traveler’s home or present duty location. It allows you to estimate
lodging and M&IE costs. You can enter a fixed amount for lodging and M&IE for each duty location using the Override button.

LOA (No Cost)—Similar to LOA (Cost); however, no obligation will be recorded in the accounting system. Used when an office es-
tablishes its obligations for LOA travel on a monthly or quarterly basis via memorandums to the accounting office.

Begin Travel: Enter the date, time and location where the traveler will begin the trip. Tip: Right-clicking in the Date field will display a
calendar that allows you to select dates by clicking on them. Select the Depart Location from the drop-down list.

Note: FTR changes as of 12/27/96 eliminate the need to enter arrival and departure times. You may not be able to access the Be-
gin Travel Time and End Travel Time fields. You will need to select a choice from the Trip Duration area that meets the traveler’s
trip criteria.

End Travel: Enter the date, time and location where the traveler will end the trip. Select the Return Location from the drop-down list.

Per Diem Locations: Contains the date(s) and time(s) the traveler arrived and departed the TDY location(s).

2C. To enter a new TDY location, select Add at the lower left hand corner of the Itinerary window. The Add Per Diem Location to Trip
dialog box appears.

The Add Per Diem Location to Trip dialog box.

2D. First, verify the accuracy of your arrival and departure dates for the Per Diem Location.

2E. Next, type the name of the city and state, or the city and country, in the Per Diem Location field and press [Tab].

2F. If Travel Manager does not recognize the location name, you will receive a prompt that looks like this:

An "Unable to find per diem location" prompt.

2G. Click the OK button to clear the Warning prompt. Then, by double-clicking in the Per Diem Location field, you can reveal the Per
Diem Lookup window. You can also use this tool if you are uncertain how to spell the location name.
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The Per Diem Lookup window. Selecting from the drop-down list in the Per Diem Lookup window.

2H. To select a state or country, first click the downward arrow in the drop-down list box at top center. You can also jump rapidly down
the list by typing the first letter of the destination.

2I. When you have picked a state or country, the city and county
locations appear in the scroll box below. To choose one of these
locations, click it once to highlight it and then click the Select but-
ton. You can also double-click the location name. The TDY location
will appear in the Add Per Diem Location for Trip dialog box seen
previously.

After selecting a state or country from the drop down list,
cities and counties appear in the Per Diem Lookup window.

2J. If necessary, click the Unlisted button to enter a city name not found in the window.

2K. The Unlisted Per Diem window appears. You are prompted to
enter the state or country abbreviation and the name of the city and
click OK. The standard CONUS or OCONUS rates for that period of
travel will be applied to your voucher.

The Unlisted Per Diem Location window.

2L. After entering the Per Diem Location, you will be returned to the Itinerary window. Verify that the location and dates appear correctly
in the lower half of the window. To add more locations, click the Add button at lower left. To edit or change a TDY location, select Up-
date. To delete a TDY location, select Delete.

2M. Up and Down Buttons: Sometimes, adding and deleting per diem locations causes the itinerary to become out of
chronological order. When you select OK to exit the Itinerary the following prompt may appear: “Itinerary dates are not in
chronological order, please edit.” The itinerary re-order buttons allow you to re-sort your itinerary. First, click on the per diem
location that you need to change. Then click the Up or Down buttons (shown at right) to rearrange the order of per diem loca-
tions in your itinerary window.

2N. When you have finished entering TDY locations, your itinerary window is complete. Click the OK button at bottom to return to the
main voucher window. By glancing at the middle portion of the window, you will notice that Travel Manager has begun calculating your
lodging and per diem allowance for the trip.
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3. Ticketed Transportation

3A. To enter or modify ticket information for common carrier modes of travel (for example, air, bus and rail), select the Tick-
eted Transportation button. The Ticket Information window appears.

The Ticket Information window.

3B. To add new ticketed transportation information, click Add. The Add Ticket Information window appears. Complete each field by
typing entries or selecting from the drop-down lists and lookup buttons. You can advance through the fields using your [Tab] key.

The Add Ticket Information window.

3C. EXPLANATION OF ADD TICKET INFORMATION WINDOW FIELDS:

Type: The type of transportation mode used for the trip (for example, Air, Bus, Rail, Ship).

Cost: The cost of the transportation mode.

Ticket No:The GTR/GTS ticket number.

Description: A description for the travel mode/ticket type. If you choose a selection from the drop-down list in the Type field, a descrip-
tion is entered for you automatically. You can override the automatic description by typing over the text in the field.

Dep Date: The date that the traveler departed for the trip.

Issue Date: The date that the transportation ticket was issued.

From/To: The departure and arrival locations. You may select an airport with the lookup button (+) or you may type in any text in the field
(up to 12 characters). If you use the lookup button, the Select Airport window appears, listing airport names and their three-letter identi-
fiers. Click a name to highlight the airport, and then click Select at lower left. You will be returned to the Add Ticket Information window.
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The Select Airport window.

The Find Airport window.

Find—In the Select Airport window, click the Find button to quickly locate an airport. The Find Airport window appears. Select the Sort
By field to look for the airport by Code or by Name. Enter the name or code of the airport in the Airport Name or Code field. You need
only enter enough letters to uniquely identify the airport name or code. Click OK when you are ready. You will be returned to the Add
Ticket Information window.

Carrier The carrier code for the ticketed transportation. Class The class code for the ticketed transportation.

Previous/Next buttons You may have several different ticket entries for a trip. To enter, view or update the information for
the next or previous ticket, select the corresponding buttons (shown at right).

3D. When you have completed each field in the Add Ticket Information Window, click the OK button. You will be returned to the Ticket
Information Window, which lists each ticket you entered. To make changes for a ticket, click the listing to highlight it, and then click the
Update button. To remove a ticket, click the listing to highlight it, then click the Delete button.

3E. When you have finished entering tickets, your Ticket Information window is complete. Click the Close button at bottom to return to the
main voucher window. By glancing at the middle portion of the window, you will notice that Travel Manager has totaled your ticket costs.

4. Expenses

4A. To quickly access the Expenses window, select the Expenses button. The Expenses Window appears, containing the date,
type and cost of any expense except per diem and ticketed transportation.

4B.  To add expense entries, click the Add button at lower left. The
Add Expense window appears. Complete each field by typing
entries or selecting from the drop-down lists. You can advance
through the fields using your [Tab] key. To select an expense from
the drop-down list, double-click on the expense name.

The Expenses window.

The Add or Update Expense window.
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4C. EXPLANATION OF ADD EXPENSE WINDOW FIELDS:

Date: The date the expense was incurred.

Expense: The type of expense incurred. If the expense is not listed in the drop-down list, you may type the expense in the text field (you
are limited to 20 characters).

Miles: If you select a mileage type of expense in the Expense field, you are prompted to enter the number of miles in the Miles field.
Note: Two types of mileage expenses are already set up in Travel Manager: ALT MILEAGE that pays .235 cents per mile and PRIVATE
VHCLE that pays .31 cents per mile.

Rate: If you select a type of mileage expense in the Expense field and enter the number of miles in the Miles field, Travel Manager auto-
matically selects the mileage rate associated with that expense and calculates the cost in the Cost field.

Cost: The cost of the expense.

Save: The Save button saves the current expense you have entered and allows you to enter another expense without exiting the Add
Expense window.

Undo: The Undo button undoes any expense you enter in the Add Expense window.

Done: Select the Done button when you are finished entering the expenses. This will close the Add Expense window.

Previous/Next buttons: You may have several different expense entries for a trip. To enter, view or update the information
for the next or previous expense, select the corresponding buttons (shown at right).

4D. When you have completed each field in the Add Expense window, click the OK button. You will be returned to the Expenses Window,
which lists each expense you entered. To make changes for an expense, click the listing to highlight it, and then click the Update button.
To remove an expense, click the listing to highlight it, then click the Delete button.

4E. When you have finished entering expenses, your Expenses window is complete. Click the Close button at bottom to return to the main
voucher window. By glancing at the middle portion of the window, you will notice that Travel Manager has totaled your expense costs.

5. Lodging/M&IE

5A. To enter lodging, actual expenses and/or any special duty conditions such as annual leave or actuals, select the Lodg-
ing/M&IE button. The Lodging and Meals window appears, containing daily expense information for lodging costs, lodging
allowed, M&IE allowed, and per diem rates.

5B.  To add lodging costs or modify M&IE amounts, click the de-
sired travel date to highlight it, then click the Update button at
lower left. The Update Lodging and M&IE Expenses window ap-
pears. Complete each field by typing entries or clicking check-
boxes or radio buttons. You can advance through the fields using
your [Tab] key.

The Lodging & Meals window.
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5C. EXPLANATION OF UPDATE LODGING AND M&IE EXPENSES
WINDOW FIELDS:

Leave Data: Indicates when a traveler is using annual or non-duty
leave while on TDY. The default for the field is always set to None.
Select Annual if the traveler used annual leave on this day while on
TDY. Select Other if the traveler is using some other (e.g., non-
duty) leave on this day while on TDY. Enter the number of annual
or other leave hours taken in the Hours field (the default value is 8).

Values Apply Through: Enter the date in which you want to
replicate lodging, meals, actuals and leave data through.

Lodging: The amount paid for the lodging.
The Update Lodging and M&IE Expenses window.

Override: To override the M&IE allowance for that day, select
Override. The Override window appears. There are two ways to
override:

Quarters—Instead of calculating the M&IE allowance based on the
itinerary, enter the number of quarters to pro-rate the allowance.

M&IE Amount—Instead of the standard M&IE rate, enter the
amount of M&IE to be used.

When you are finished entering override information, click the OK
button at bottom center. You will be returned to the Lodging and
M&IE Expenses window.

The Override window.

Actuals: When actual lodging or M&IE expenses were incurred (these expenses must be approved by an authorizing official within the
agency).

Lodging—When the lodging field is checked, actual lodging expenses are claimed. The Limit field displays the maximum actual lodging
amount authorized.

Meals—When the meals checkbox is checked, enter the meal expense amount claimed for each field: Breakfast, Lunch, Dinner, and
Incidentals. At this time, this portion is not regularly used by FAA organizations.

Meals Provided—Click in the appropriate check boxes to indicate any meals for which the traveler should not be reimbursed on that day.

Previous/Next buttons You may have several different lodging and M&IE entries for a trip. To enter, view or update the
information for the next or previous entry, select the corresponding buttons (shown at right).

5D. When you have completed each field in the Update Lodging and M&IE Expenses window, click the OK button. You will be returned to
the Lodging and Meals Window, which lists each day you entered. To make changes for a day, click the listing to highlight it, and then
click the Update button. To remove a day, click the listing to highlight it, then click the Delete button. And to apply the same lodging and
M&IE amounts to a series of days, click to highlight the first day in the sequence, then click the Replicate button. The amounts will be
copied to every day following the one you highlighted.

5E. When you have finished entering lodging and M&IE, your Lodging and Meals window is complete. Click the Close button at bottom to
return to the main voucher window. By glancing at the middle portion of the window, you will notice that Travel Manager has totaled your
lodging and meal costs for the trip.
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6. Accounting

6A. To specify the accounting code or codes used to fund the trip, select the Accounting Button. The Accounting Codes win-
dow appears.

The Accounting Codes window.

6B. The Master Accounting Codes list (top half of window) displays the accounting codes setup for your organization.

Select - When you highlight an accounting code from the Master Accounting Codes list by clicking its name, clicking the Select button
will add it to the Accounting Codes for Current Document list (bottom half of window). If you only need to indicate this one accounting
code for the voucher, click the Close button. You will be returned to the main voucher window.

Find - Allows you to search for a specific accounting code. In the
Label field, enter enough characters of the accounting code label
name to uniquely identify the code. Click OK when finished. You
will be returned to the Accounting Codes window.

The Find Accounting Code window.

Org - Allows you to change the Organization to select from a dif-
ferent list of accounting codes, as stored by different Organizations
in the Travel Manager database. Click OK when finished. You will
be returned to the Accounting Codes window.

The Change Organization window.

6C. New - If the accounting code you want does not appear in the master list, you can add it now for use on this voucher and in the fu-
ture. Select New from the center right in the Accounting Codes window to add a new accounting code classification. The Add Accounting
Code window will display.

In the Label field at top, enter any descriptive label for the code
and select an organization if available from the list. When entering
the parts of the accounting code, you can advance from one field
to the next using your [Tab] key. When finished, click the OK but-
ton at upper right. You may be prompted “Do you want to save this
accounting code to the master list of accounting classifications?”

• To add the accounting code permanently to the Master Ac-
counting Codes list, select Yes.

• To save the code only to this document, select No.

After answering the prompt, you will be returned to the Accounting
Codes window.

The Add Accounting Code window.
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6D. Update - If you need to change an accounting code that you have selected from the master list in the Accounting Codes window,
highlight the code and then click the Update button at center right. This displays a window identical to the Add Accounting Code window.
It allows you to edit or change the selected code in the Accounting Codes for Current Document list. When finished, click the OK button
at upper right. You may be prompted “Do you want to save this accounting code to the master list of accounting classifications?”

• To add the accounting code permanently to the Master Accounting Codes list, select Yes.
• To save the accounting code only to this document, select No.

After answering the prompt, you will be returned to the Accounting Codes window.

Delete - If you need to remove an accounting code that you have selected from the master list in the Accounting Codes window, highlight
the code and then click the Delete button at center right.

6E. Allocate - This selection is available only when two or more accounting codes have been selected for the document. Selecting Allo-
cate will display the Allocate Accounts window.

Travel Manager displays account information in two levels:

Account Allocation Summary, top of window - Displays the ac-
counting code, amount allocated to the code, the percentage of
total costs allocated to the code, and the date the code should
begin to accumulate.

Expense Category Allocation Breakdown, bottom of window -
Displays the amount of each expense item to allocate to each ac-
counting code (for example, one accounting code pays for lodging
and another accounting code pays for all other expenses).

There are four methods by which you can allocate expenses
across multiple accounting codes: The Allocate Accounts window.

Percent—Highlighting an accounting code in the Account Alloca-
tion Summary list and selecting Percent allows you to enter a per-
centage of total costs to allocate to the accounting code. (For
example, one accounting code pays 30% and the second ac-
counting code pays 70%.) Click OK when finished. You will be
returned to the Allocate Accounts window. The Update Allocation Percentage window.

Date—Highlighting an accounting code in the Account Allocation
Summary list and selecting Date allows you to indicate the date
when expenses for the code should begin to accumulate. For ex-
ample, one code pays for the first week of travel and another code
pays for the second week of travel. Click OK when finished. You
will be returned to the Allocate Accounts window. The Update Allocation Dates window.

Expense—Highlighting an accounting code in the Account Alloca-
tion Summary list and selecting Expense allows you to indicate
what expense categories are assigned to the accounting code. For
example, one accounting code pays for Common Carrier costs and
another accounting code pays for M&IE costs.

The Arrange Expense Categories window.
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To assign an expense to an accounting code:
1. Highlight the desired accounting code in the Account Allocation Summary list and select Expense.
2. Highlight the desired category in the Expense Categories list and select Add. The selected expense is listed in the Selected Ex-
pense Categories list. Repeat as necessary. Click OK when finished. You will be returned to the Allocate Accounts window.
3. To remove an expense from an accounting code, highlight the desired expense in the Selected Expense Categories list and select
Remove. The selected expense is listed in the Expense Categories list and is no longer assigned to the selected accounting code.

Amount—Highlighting an accounting code in the Expense Cate-
gory Allocation Breakdown list and selecting Amount allows you
to indicate the amount of each expense item to allocate to the
accounting code. For example, one accounting code pays $100 of
the trip’s expense, the other pays the rest. Click OK when finished.
You will be returned to the Allocate Accounts window.

The Update Allocation Account window.

Extended Each standard accounting code may have one or more five-part extensions. Extended accounting codes are used to support
more detailed or complex accounting structures. The five-part extensions of extended accounting codes are not displayed during docu-
ment preparation and are not printed on standard government forms.

At this time, extended accounting codes are not regularly used by FAA organizations.

6F. When you have finished allocating accounts, click the Close button at the bottom of the Allocate Accounts window. You will be re-
turned to the Accounting Codes window, which lists each code you entered.

6G. When you have finished entering account codes, your Accounting Codes window is complete. Click the Close button at bottom right
to return to the main voucher window. By glancing at the lower left portion of the window, you will notice that Travel Manager displays a
portion of the first account code used for this voucher.

7. Comments
7A. To enter any additional comments or text that have not already been entered elsewhere in the document, select the Com-
ments button. The Comments window appears.

7B. Type your comments as needed in the text area and click the
OK button at lower right when finished. You will be returned to the
main voucher window.

The Comments window.

7C. If there is one comment that you always enter in your vouchers, you can save some typing by using the Preset comment function.
Click the Preset button at lower left. The Preset Comments window appears.

If your organization’s database configuration allows, type your
preset comments in the text box. (If not, consult your organiza-
tion‘s Travel Manager System Administrator. When you click the
Select button at lower right, the comments will be permanently
saved, and applied to your current voucher as well. You will be
returned to the Comments window, where the preset comments
will appear in the text box. If satisfied, click the OK button at lower
right. You will be returned to the main voucher window.

The Preset Comments window.
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8. Totals
8A. To view the total expenses claimed on the document, select the Totals button. The Totals for Voucher window appears.

8B. EXPLANATION OF TOTALS WINDOW FIELDS:

Total Expenses - The total amount claimed on the voucher (lodg-
ing, M&IE, ticketed transportation and expenses).

Non-reimbursable Expenses - The total amount of all non-
reimbursable expenses claimed on the document.

Total Amount Claimed - The total amount of all expenses claimed,
minus any non-reimbursable expenses.

Gov’t Advance Outstanding - When you create a voucher from an
authorization, this field displays the total requested cash advance
amount from the authorization. When you create a voucher from
scratch, this field defaults to $0.00. You may override the default
by entering the requested cash advance amount. The Totals for Voucher window.

Gov’t Advance Applied - By default, the amount displayed in the Gov’t Advance Outstanding field is entered in this field. You may over-
ride the default by entering any amount.

Net to Traveler - The total amount claimed, less the amount entered in the Gov’t Advance Applied field. If a negative amount is displayed,
the traveler owes the government.

Expenses on Government Charge Card - All reimbursable expenses with a payment method of GOVERNMENT CHARGE CARD.

ATM Advance - If you enter an ATM Advance Fee in the Expenses window, Travel Manager calculates the advance amount based on a
2.75% fee and enters the advance amount here.

Additional Government Charge Card Payment - Enter any other amount to be paid to the traveler’s government card account.

Total Government Charge Card Payment and Pay to Government Charge Card - The total amount to be paid to the traveler’s govern-
ment credit card account (the sum of the three expenses described above).

Pay to Traveler - The total amount due the traveler (the total displayed in Net to Traveler field less the amount displayed in Pay to AMEX
field).

Detail - Detailed accounting information for the document, such as
expense categories, accounting code for each expense category,
and the amount applied to each category.

The Detail (Expense Categories for Voucher) window.
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9. Document Status
9A. The status window is used with electronic processing of travel documents. Consult your Travel Manager System Adminis-
trator to determine whether this procedure is used in your organization, and if so, refer to Electronic Processing.

10. Save Your Voucher
10A. Refer to Saving and Printing Your Documents.

11. Print Your Voucher
11A. Refer to Saving and Printing Your Documents.

12. Close the voucher file.
12A. Select Close from the File menu. You will be prompted to save the file again; this is normal. You may disregard or choose to re-save
the file.

13. Exit Travel Manager.
13A. Select Exit from the File menu.
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Creating a New Travel Authorization (Travel Orders)Creating a New Travel Authorization (Travel Orders)

1. Create the authorization file.
1A. From the File menu, select New. From the submenu, select
Authorization.

The File menu and the New submenu.

1B. An Untitled authorization window appears. Enter
the traveler’s SSN and press [Tab].

1C. If this traveler is not in the Travel Manager
database and the system will not allow you to add the
traveler, consult your organization's Travel Manager
System Administrator.

1D. Enter the Authorization Number in its field at the
upper right portion of the Untitled voucher window.

New window for an untilled authorization.

2. Itinerary

2A. To enter the itinerary information, select the Itinerary button. The Itinerary window appears. Complete each field by typing
entries or selecting from the drop-down lists. You can advance through the fields using your [Tab] key. Detailed instructions
for the Itinerary window appear in Section 2 of Creating a New Travel Voucher.

3. Ticketed Transportation

3A. To enter or modify ticket information for common carrier modes of travel (for example, air, bus and rail), select the Tick-
eted Transportation button. The Ticket Information window appears. To add new ticketed transportation information, click the
Add button at lower left. The Add Ticket Information window appears. Complete each field by typing entries or selecting from
the drop-down lists. You can advance through the fields using your [Tab] key. Detailed instructions for the Ticket Information
window appear in Section 3 of Creating a New Travel Voucher.

4. Expenses

4A. To quickly access the Expenses Window, select the Expenses button. The Expenses Window appears. To add (antici-
pated) expense entries, click the Add button at lower left. The Add Expense window appears. Complete each field by typing
entries or selecting from the drop-down lists. You can advance through the fields using your [Tab] key. To select an expense
from the drop-down list, double-click on the expense name. Detailed instructions for the Expenses window appear in Section 4
of Creating a New Travel Voucher.
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5. Lodging/M&IE

5A. To enter lodging, actual expenses and/or any special duty conditions such as annual leave or actuals, select the Lodg-
ing/M&IE button. The lodging and meals window appears, containing daily expense information for lodging costs, lodging
allowed, M&IE allowed, and per diem rates. To add lodging costs or modify M&IE amounts, click the desired travel date to
highlight it, then click the Update button at lower left. The Update Lodging and M&IE Expenses window appears. Complete
each field by typing entries or clicking checkboxes or radio buttons. You can advance through the fields using your [Tab] key.
Detailed instructions for the Lodging/M&IE window appear in Section 5 of Creating a New Travel Voucher.

6. Special Authorizations

6A. To access the Other Authorizations Window in an Authorization, select the Other Authorizations button. The Other
Authorizations window appears.

The Other Authorizations window is used to display and print re-
marks on travel documents. You must indicate special circum-
stances -- for example, annual leave -- in the M&IE screen (Step 5)
to have your document calculation reflect them. When you select a
travel cash advance or leave through the Lodging/M&IE or Totals
window, its corresponding remark will be automatically reflected in
Other Authorizations.

The Other Authorizations window contains two lists:

Other Authorizations - Displays a list of available special authori-
zation codes. To select a code, double-click on the desired code,
or highlight the code and choose Select. When you perform this
action, the Remarks window appears.

The Other Authorizations window.

Remarks displays the preset remarks associated with the other
authorization selected. You can add, delete or remove additional
remarks by clicking in the text field and using the usual text editing
features found in Windows.

When finished, click OK and you are returned to the Other Authori-
zations window.

The Other Authorizations Remarks window.

6B. Other Authorizations for Current Document, in the lower half of the window, displays a list of the codes chosen for this trip.

6C. To remove a code, click on the desired code to highlight it, and select Remove.

The Remarks button at lower right also allows you to re-edit the preset or custom remarks assigned to one of the listed authorizations.
Just click on the code to highlight it, and click the Remarks button.

6D. Click Close at lower right when finished with the Other Authorizations window. You are returned to the main screen for your Travel
Authorization.

7. Accounting

7A. To specify the accounting code or codes used to fund the trip, select the Accounting Button. The Accounting Codes win-
dow appears. Detailed instructions for the Accounting Codes window appear in Section 6 of Creating a New Travel Voucher.
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8. Comments
8A. To enter any additional comments or text that have not already been entered elsewhere in the document, select the Com-
ments button. The Comments window appears. Detailed instructions for the Comments window appear in Section 7 of Cre-
ating a New Travel Voucher.

9. Totals
9A. To view the total expenses claimed on the document, select the Totals button. The Totals for Authorization window ap-
pears.

The Totals for Authorization window.

9B. Clicking the Detail… button displays the Expense Categories
for Authorization window.

It contains detailed accounting information for the document, such
as expense categories, accounting code for each expense cate-
gory, the amount applied to each category, and the advance
amount for each expense category. When you are satisfied with
the data, click the Close button to return to the Totals for Authori-
zation window. The Expense Categories for Authorization window.

9C. Clicking the Advance button in the Totals for Authorization
window displays the Cash Advances for Authorization window.

It contains travel cash advance request information (if any). You
may add, update or delete a travel cash advance for the document.
To request a travel cash advance, click the Add button at bottom
left. The Add a Cash Advance window appears.

The Cash Advances for Authorization window.

9D. Complete each field by typing entries or selecting them from
drop-down menus or lookup buttons. You can advance through the
fields using your [Tab] key.

9E. EXPLANATION OF ADD A CASH ADVANCE WINDOW FIELDS:

Date - Enter the date for the travel cash advance.

Type - Select the type of advance from the drop-down list.

Amount - Enter the travel cash advance amount. Note: Travel Man-
ager calculates the travel cash advance based on the traveler’s
charge card type.

Account - Select the accounting code. (This field may already be
completed if you have chosen an accounting code in the Account
window, Step 7).

Remarks - Enter any comments.

The Add a Cash Advance window.
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9F. When you have completed entries in the Add a Cash Advance window, click the OK button at bottom. You are returned to the Cash
Advances for Authorization window.

9G. To delete a travel cash advance, click to highlight the desired travel cash advance and select Delete.

At the prompt, “Are you sure you want to delete this record?”,
select Yes. You are returned to the Cash Advances for Authoriza-
tion window.

A confirmation prompt.

9H. To update a travel cash advance, click Update. The Update a Cash Advance window opens, identical to the Add a Cash Advance
window shown in Step 9D.

9I. To print a travel cash advance, click the Print button. To proceed from here, refer to Saving and Printing Your Documents.

9J. When you are finished entering or modifying cash advances, click the Close button at lower right to close the Cash Advance for
Authorization window. You are returned to the Totals for Authorization window. When satisfied, select Close. You are returned to the main
screen for your Travel Authorization.

10. Document Status
10A. The status window is used with electronic processing of travel documents. Consult your Travel Manager System Admin-
istrator to determine whether this procedure is used in your organization, and if so, refer to Electronic Processing.

11. Save Your Authorization.
11A. Refer to Saving and Printing Your Documents.

12. Print Your Authorization.
12A. Refer to Saving and Printing Your Documents.

13. Close the Authorization file.
13A. Select Close from the File menu. You will be prompted to save the file again; this is normal. You may disregard or choose to re-save
the file.

14. Exit Travel Manager.
14A. Select Exit from the File menu.
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Creating a New Local VoucherCreating a New Local Voucher

1. Create the local voucher file.

1A. Click the New Document button on the toolbar. The New Document
window appears. Click the radio button for Local Voucher and click the OK
button. This is an alternative to the method shown in Creating a New Travel
Voucher and Creating a New Travel Authorization (Travel Orders).

The New Document Button and Window.

1B. An Untitled local voucher window appears. Enter the
traveler’s SSN and press [Tab].

1C. If this traveler is not in the Travel Manager database
and the system will not allow you to add the traveler,
contact the Travel Manager System Administrator for
your organization.

New window for an untilled local voucher.

2. Expenses

2A. To quickly access the Expenses window, select the Expenses button. The Expenses Window appears, containing the date,
type, code and cost of any expense.

2B.  To add expense entries, click the Add button at lower left. The
Add Expense window appears. Complete each field by typing
entries or selecting from the drop-down lists. You can advance
through the fields using your [Tab] key. To select an expense from
the drop-down list, double-click on the expense name.

The Expenses window.
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The Add or Update Expense window.

2C. EXPLANATION OF ADD EXPENSE WINDOW FIELDS:

Date: The date the expense was incurred.

Description: The type of expense incurred. If the expense is not listed in the drop-down list, you may type the expense in the text field
(you are limited to 40 characters). Note: ‘1 POC’ refers to automobile mileage.

Code: There are three selections to choose from; each will print in the CODE field of government form 1164. Valid values are: A - Local
Travel—local transportation expenses and toll fares; B - Phone—telephone or telegraph expenses; C - Expenses—other expenses.

Miles: If you select a mileage type of expense in the Expense field, you are prompted to enter the number of miles in the Miles field.

Rate: If you select a type of mileage expense in the Expense field and enter the number of miles in the Miles field, Travel Manager auto-
matically selects the mileage rate associated with that expense and calculates the cost in the Cost field.

Cost: The cost of the expense.

No. of People: Enter a number that will print on the 1164 government form in the Add Persons field, if applicable.

Save: This button saves the current expense you have entered and allows you to enter another without exiting the Add Expense window.

Undo: The Undo button undoes any expense you enter in the Add Expense window.

Done: Select the Done button when you are finished entering the expenses. This will close the Add Expense window.

Previous/Next buttons: You may have several different expense entries for a trip. To enter, view or update the information
for the next or previous expense, select the corresponding buttons (shown at right).

2D. When you have completed each field in the Add Expense window, click the OK button. You will be returned to the Expenses Window,
which lists each expense you entered. To make changes for an expense, click the listing to highlight it, and then click the Update button.
To remove an expense, click the listing to highlight it, then click the Delete button.

2E. When you have finished entering expenses, your Expenses window is complete. Click the Close button at bottom to return to the main
voucher window. By glancing at the middle portion of the window, you will notice that Travel Manager has totaled your expense costs.

3. Accounting
3A. To specify the accounting code used to fund the local expenses, click the Accounting Button. The Accounting Codes win-
dow appears. Detailed instructions for the Accounting Codes window appear in Section 6 of Creating a New Travel Voucher.

4. Comments
4A. To enter any additional comments or text that have not already been entered elsewhere in the document, select the Com-
ments button. The Comments window appears. Detailed instructions for the Comments window appear in Section 7 of Cre-
ating a New Travel Voucher.
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5. Totals
5A. To view the total expenses claimed on the document, select the Totals button. The Totals for Voucher window appears.
Detailed instructions for the Totals window appear in Section 8 of Creating a New Travel Voucher.

6. Document Status
6A. The status window is used with electronic processing of travel documents. Consult your Travel Manager System Adminis-
trator to determine whether this procedure is used in your organization, and if so, refer to Electronic Processing.

7. Save Your Local Voucher
7A. Refer to Saving and Printing Your Documents.

8. Print Your Local Voucher
8A. Refer to Saving and Printing Your Documents.

9. Close the local voucher file.
9A. Select Close from the File menu. You will be prompted to save the file again; this is normal. You may disregard or choose to re-save
the file.

10. Exit Travel Manager.
10A. Select Exit from the File menu.
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Electronic ProcessingElectronic Processing
The next phase for travel processing is the electronic signature and submission of travel documents directly from Travel Manager to your
accounting office. This paperless system eliminates the paper travel authorization, paper travel voucher, and the written signature.

Reimbursements via Electronic Funds Transfer (EFT)
Electronic Funds Transfer, or "direct deposit," can be used for making travel reimbursements. The envisioned potential for this process is
having reimbursement for travel vouchers available in the traveler's bank account the next working day after electronic approval.

Retention of Official File and Receipts
The program office and/or traveler must retain a hard copy of the travel document as well as all receipts for six years. It is suggested that
a hard copy of the travel authorization and the travel voucher with receipts be stored in a file with the trip dates and destinations labeled
on the outside, so that they may be easily turned over to Accounting Office personnel when requested. Only receipts for lodging and ex-
penses over $75 are required.

Process Overview and Comparison

Travel Authorization

Old Method New Method
1. Travel Authorization (TA) is prepared in Travel Manager. 1. TA is prepared in TM and traveler/designated person elec-

tronically signs TA.
2. Approving Official approves hard-copy of TA. 2. Approving Official electronically approves TA.
3. Accounting Office manually records obligation into ac-

counting system.
3. System Administrator exports approved document into

accounting office interface for transfer to DAFIS.
4. Advances are received via ATM or office cashier. 4. Same.
5. Travel takes place. 5. Same.

Travel Voucher

Old Method New Method
1. Travel voucher is prepared in TM. 1. Same.
2. Traveler manually signs hard-copy of voucher. 2. Traveler electronically signs the voucher in TM.
3. Approving Official approves hard-copy of voucher. 3. Approving Official electronically approves voucher in TM.
4. Voucher is mailed or hand-carried to the Accounting Office. 4. TM System Administrator exports approved document into

accounting office interface for transfer to DAFIS.
5. Traveler receives reimbursement by EFT or Treasury check. 5. Traveler receives next day reimbursement by direct deposit.
6. Voucher and receipts are filed and stored by Accounting. 7. Receipts are retained by traveler and/or program office.

Guide to Status Codes

Not all codes may be used by your organization. Consult your Travel Manager System Administrator as needed.

Created - New document that has not been signed or routed.
Submitted - Traveler signs. This action starts the routing process.
Reviewed - First level of approval (optional).
Authorized - Second level of approval (optional).
Approved - Highest level of approval. This is required.
Pending -Some part of the document has failed electronic audit
and requires further review.
Adjusted - A signor has changed part of the original document.

Audit Pass - Some part of the document has failed electronic audit.
The document was reviewed and passed.

Audit Fail - Some part of the document has failed electronic audit
and requires corrections.

Disapproved - Document has not been approved and has been
sent back to the traveler.

Data Link - The document has passed audit and is ready for inter-
face to the accounting system.
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Electronic Signature and Routing

An encrypted 16-character code is associated with a signor's public name. Whenever a person changes the status of a document, the
electronic signature of the person must be entered. A status history record, maintained with each document, shows each status change
and who signed. The system administrator must activate electronic signature processing and enter the user in the signature table. When
the user next launches Travel Manager, he/she will be prompted to enter a new signature code.

Setting Your Personal Electronic Signature

1. Launch the Doc Prep module.
2. Enter a new electronic signature password (8-16 characters and containing at least one digit). Passwords are case sensitive.
3. Tab and reenter electronic signature to verify; then click the OK button.

If the user cannot remember this signature later, they can ask their Travel Manager System Administrator to reset it to blank.

Signing and Submitting a Document

1. In the Doc Prep module, prepare and save the document. Note: The initial status of the document is Created. Do not change the status
until the document is ready to be routed. By changing the status, the signer initiates the electronic routing process.

2. Click the Document Status icon in the lower right corner of the screen. The Document Status window appears.

The Document Status window.

3. Click on the downward-pointing arrow on the Status field at upper left and double click on Submitted.

4. Enter the code for your electronic autograph in the Signature field at upper right.

5. Click the OK button at upper right. You will be prompted to confirm saving and routing of the document. For travel vouchers and local
vouchers, you will also be prompted to confirm a certification statement.

6. To review the status history of a document, examine the Document History browser in the lower right corner of the Status window.
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Reviewing, Approving and Signing an Authorization

At this point, the supervisor/authorizing official receives the document awaiting review.

1. Launch the Doc Prep module.

2. Select Review from the File menu.

3. Select the appropriate document and review it onscreen or as a printed copy if preferred.

4. Approve and electronically sign the document by following the same instructions as listed in the previous segment, Signing and Sub-
mitting an Authorization, except change the document status to either Approved or Disapproved.

5. If prompted, click on the appropriate response to the message, "Have you made any adjustments to the current authorization?"

Delegating Authority

When a person with authority to authorize or approve travel documents is not available to sign, they may delegate their authority. When
signature authority is delegated, the document is routed to both the approving official and to the delegatee. When the document is signed
by either one, it is removed from both of their review lists. The delegation of authority is effective only for documents submitted after the
delegation has taken place.

Activating Delegate Authority:

1. In the Doc Prep module, choose Delegate Authority from the Setup menu.
2. A list of users will be displayed. Scroll to the name of the person of your choice, highlight it
and click Select.
3. When prompted, enter the code for your electronic signature to verify the delegation of author-
ity and click OK.
4. Note that the Authority delegated to: field has the name of the person you selected in step
#2.
5. To exit the Delegate Authority window, select Close.

The delegation will remain in effect until deleted. So upon return, the delegation must be deleted.

The Delegate Authority window.

Deactivating Delegate Authority:

1. In the Doc Prep module, choose Delegate Authority from the Setup menu.
2. Click on Delete, and confirm when prompted.
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Saving and Printing Your DocumentsSaving and Printing Your Documents

Saving Your Documents

1. From the File menu, select Save. The Save As window appears.

2. At the Save As window, enter a name in the Name field (or select the one that is already filled
in, based on your authorization number). Click OK to accept the document name. You can verify
that the voucher was saved correctly by observing the new name as it appears in the title bar of
the voucher window.

The Save As window.

About File Names: Travel Manager defaults the document name to the Travel Authorization Number. Technically, you can replace the
default name with any other name that you want. The name is used internally in the Travel Manager database and therefore does not have
to follow DOS filename conventions. The name may contain any combination of numbers, letters or spaces. However, to use the interface
between Travel Manager's electronic processing and the FAA's accounting system, you will want to follow the file naming scheme de-
scribed in the Appendix, Travel Document Number Structure and NATS.

Re-saving files: If a document was previously saved under the same name, you will be prompted to overwrite the existing document.
Warning: Overwriting an existing document will delete the previously saved document. If you select No when prompted to save the
document, Travel Manager lets you reselect Save or Save As and assign a new name to the document.

Saving and Closing: When you close the document, or if you exit Travel Manager while a document is open, you will automatically be
prompted whether you wish to save the document. This will be the case even if you saved the document only two seconds before. You
do not need to save it a second time - unless you have made changes.

Printing Your Documents

1. From the File menu, select Form Setup to select the type of form to be printed or viewed. The Form Setup window appears.

EXPLANATION OF FORM SETUP WINDOW FIELDS.

To print all the travel data in a comprehensive, easy-to-read format,
select Default.

To print the document information and government travel form on
plain paper, select Govt+Form.

To print the document on a pre-printed government form, select
Govt. Insert a government form into your printer and Travel Man-
ager will “fill out” the form blocks.

The Form Setup window.

To print a page listing the receipts to be attached to the voucher, check Receipt Checklist.

To turn off the printing of a travel cash advance, select None in the lower-center portion of the window.

To print the electronic history and show each step in the electronic approval and processing of the document, check Document History.
To print the Privacy Act Statement, select Privacy Act. To print subtotals of a document’s expenses by accounting code and Expense
Category, select Accounting Detail.
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A document printed in the Default format. A document printed in the Govt+Form format.

2. From the File menu, select Print Preview to view the document. Print Preview is available only when the document is open.

The Print Preview window is displayed.

To set the document view in the Print Preview window
to actual size, click the 100% button.

To set the document view in the Print Preview window
to display an entire page at a time, click the Full Page
button.

Use the Prev Page and Next Page buttons to advance
backward and forward through the document's pages
and attachments.

To print the document, click the Print button. The asso-
ciated steps are described in Step 3 below.

To adjust the amount of the document shown in the
window, click the Zoom button at lower left.

A document displayed in the Print Preview window.

The Zoom Value window appears.

In the text field at bottom, enter a percentage as specified and click
the OK button. The picture in the Print Preview window is adjusted
accordingly.

Click the Close button to exit the Print Preview window.

The Zoom Value window.

3. To print the document, select Print from the File menu or click
the Print button in the Print Preview window. The standard Win-
dows Print dialog box appears.

In the Print Range area, specify the number of pages. Make printer
selections or adjustments using the Setup button if necessary.
Click OK when finished to send the print job to the printer.

The Print dialog box.
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Browsing Per Diem RatesBrowsing Per Diem Rates
Travel Manager stores two types of rates: standard and custom. Standard rates are GSA/State Department locations and are updated
monthly. Custom rates are special rates entered by end users or System Administrators - they are not updated. Custom rates usually
represent agency-defined per diem rates for situations like training or extended TDY assignments.

Standard and custom rates are displayed together alphabetically, by location name, when “browsing” per diem rates or when selecting a
per diem rate location in an itinerary. Custom rates are marked with an asterisk (*) when displayed in a per diem location list.

Travel Manager automatically installs the domestic (CONUS) and foreign (OCONUS) rates. Foreign rates may change monthly. As a re-
sult, the foreign rates that are installed with Travel Manager will eventually become outdated. Foreign rates are updated monthly through
the Gelco Maintenance Subscription Service.

To review per diem and lodging rates for travel destinations,
click the Rates button, which depicts a city skyline with a
dollar symbol.

The Location window appears.

There are two main browsers in the Locations window: the
‘Location’ browser (top) and the ‘Rate’ browser (bottom).

State/Country - The state or country of the per diem loca-
tion (top).

The Location window.

The Location Browser (middle left) displays all city and/or county
locations within the state or country selected. The browser is up-
dated each time a different state/country is selected. Each field
within the Location browser is described below.

Location—The per diem location within the selected state or
country. The location may be a city, a county or both. When a
location is displayed as City/County (for example,
Fairfax/County, the “/” indicates that this rate is effective for
both Fairfax City and Fairfax County.

County—The county for the per diem location within the se-
lected state or country.

Linked—YES indicates that the selected per diem location is
linked to another location (standard or custom) in the rate ta-
ble. A per diem location that refers to another location for its
rate information is called a Linked Rate.

Comments—A descriptive entry about the selected location
(optional).

The Rate Browser (across the bottom of the window) displays the
lodging and M&IE rates for the location highlighted in the Location
browser. Each field is described below:

Lodging - The maximum lodging allowance for the location.

M&IE - Displays the M&IE (meals and incidental expenses)
allowance for the per diem location.

Eff Date - The effective or first date this rate can be used. A
rate is in effect until one with a more current effective date
exists in the table or until the expiration date has passed.

Exp Date - The expiration or last date this rate can be used.

Snl St/ Snl End —The season start and end date for this per
diem rate. When no season start or end date is entered, the
date defaults to 01/01 or 12/31 respectively. Seasonal start
and end dates are only used in seasonal locations where the
per diem rate changes at specific intervals during the year.
(Browse Puerto Rico to see an example of a seasonal rates).

Comment—A descriptive entry about the selected rate.
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Filters

Location Types - Allows you to choose how to fill the State/Country field. Each selection is described below:

CONUS—Displays only the per diem locations in the continental US in the State/Country field.
OCONUS/Foreign—Displays only the foreign and US locations outside the continental US in the State/Country field.
All—Displays both CONUS and OCONUS locations in the State/Country field.

Time Period - Selection of any one of the time options determines how the Rates browser is filled. All locations are shown, but only rates
that match the selection are given. For example, there may be some locations showing no rate. Each selection in the Time Period field is
described below:

Entire History—Displays all rates stored in your Travel Manager database.
Effective Now—Displays rates effective during the time period selected.
Specific Period—Displays rates effective during a specific time period. To specify the specific time period, enter a start date in

the From field and an end date in the To field.
Changes Only—Displays rates that have changed during a specific time period. To specify the changes only time period, enter

a start date in the From field and an end date in the To field.
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Guide to Toolbar and Menus - Document Preparation ModuleGuide to Toolbar and Menus - Document Preparation Module

To run the Doc Prep module, double-click on the program icon TM v7.0 Doc Prep. In Windows 95or 98, click your Start Button, go to
the Programs menu, then go to the Travel Manager submenu, and select this shortcut). Doc Prep provides basic user functionality. It is
used to create, sign and review Authorizations, Vouchers, Local Vouchers and Amendments. It also includes the Rates, Reports, abbrevi-
ated Setup and Utilities menus. Depending on your security level, you may be able to access other modules from the Modules menu.

Main Window - Doc Prep Module

Menu Bar
To access menu items in each module, press [Alt+letter] (where the letter of the item is underlined), click on the menu item, or press
[F10] then use the arrow keys to highlight the desired item.

The File Menu and Matching Toolbar Buttons

New: To create a new travel document, select New. Selecting New will open a submenu with a list of available document
types.

Authorization: A temporary duty travel authorization or request used to authorize travel. Travel Manager uses the information entered to
estimate the cost of travel and the cash advance amount. A cash advance request form may be prepared as part of the authorization.

Voucher: A temporary duty travel reimbursement voucher that is completed when travel has concluded. A voucher is used to claim reim-
bursement for various travel expenses. When this document type is selected, a blank voucher screen appears, and the voucher may be
completed from scratch. It is not necessary to have entered an authorization in order to prepare a voucher.

Voucher From Authorization: A voucher created from an existing travel authorization. When you select Voucher from Authorization, the
Voucher From Authorization window displays. Highlight a traveler and an existing authorization and select OK. Travel Manager will create
a voucher using the data previously entered in the authorization. Complete the voucher by entering any details that were not available in
the authorization, such as departure and arrival times, and by supplying actual, not estimated, expenses.

Local Voucher: A document used to claim reimbursement for miscellaneous expenses incurred by a government employee. Local vouch-
ers do not include per diem allowances and are normally associated with the SF1164 form.

Amendment: A document that is used to submit a change to an authorization or voucher that has already been processed by your ac-
counting system. Amendments can be created only for documents that have an electronic processing action code of ‘Complete’.

Delete: To permanently remove documents from the Travel Manager database, select Delete and use the same identification process
shown for Open on the next page. You will be prompted to confirm the deletion.

Close: Close is available only when a document is open. If you select Close, you will be prompted to save the current document. If you
select Yes, you will be prompted to enter a name to assign to the document.

Review: Selecting Review displays a list of the documents that are waiting for the on-screen review and electronic signature of a review-
ing or approving official. Identify the document you want to review using the same identification process shown for Open on the next
page.  If documents are awaiting your review, you will be notified when you first log in to Travel Manager.
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Open: To retrieve a previously saved document, select Open. The Open Document window appears.

First, click the name from the list at right to highlight the traveler
whose document you want to open. Using the radio buttons at
upper right, the list of travelers can be displayed alphabetically
by Last Name or numerically by SSN.

Documents appear in the list at left when a traveler is selected.
The list of document names can be filtered by document type
using the drop-down list at lower left. The documents are listed
by first day of travel and the first two characters indicate docu-
ment type: TA=Authorization, TV=Travel Voucher, LV=Local
Voucher. Click the OK button when finished. The Open Document window.

Save and Save As: To save a new document or to save changes to an existing document, select Save. Save is available only
when a document is open. Saving the document takes the information on screen (including the details in each data entry win-
dow) and saves it to disk. Select Save As to to save changes to an existing document under a new name.

Refer to Saving and Printing Your Documents for more details.

Import: The Import function allows you to import an authorization, voucher, or local voucher from a file created by another copy of Travel
Manager. Importing is the act of converting the file from a text format back into a file that can be edited in Travel Manager. Documents
from Versions 4.0, 4.1 and 5.0 of Travel Manager may be imported into this version; however, some of the information not collected in
previous versions will be blank. Documents from versions earlier than 4.0 may not be imported into Travel Manager v7.0. Selecting the
Import command displays the Import a Document window.

Click the appropriate radio button to indicate the file type of docu-
ment to import. Enter the file name of the document to be im-
ported. Enter the full directory and file path if necessary, as shown.
Select Browse to access a standard Windows file browser. Click
OK when finished. The imported files can be accessed as shown in
Open above. The Import a Document window.

Export: Travel Manager will export (convert and save) all of the data associated with the current document to an ASCII (text) file. The file
generated contains data for one and only one document. The Export command is available only when a document is open.

Enter the file name of the document to be imported. Enter the full
directory and file path if necessary, as shown. Select Browse to
access a standard Windows file browser. Click OK when finished.

The Export Document window.

Print, Print Preview and Form Setup: To access a standard Windows print dialog box, select Print. Select Print
Preview to view the document and Form Setup to select the type of form to be printed or viewed. Print and Print Pre-
view are only available when a document is open. Refer to Saving and Printing Your Documents for more details.

Exit: To exit Travel Manager, select Exit from the File menu. If a document is open, you will be prompted to save the document before
exiting Travel Manager. To close the main window, select OK.

The Document Menu

The Document menu (available only when a document is open) provides access to the data entry windows in a document. It displays
different choices depending on the type of document you have open. Clicking the commands allows you to navigate through the sections
of the document instead of clicking the buttons in the main window of the document. For example, clicking the Itinerary command on the
Document menu will have the same effect as clicking the Itinerary button in the window -- it will reveal the Itinerary window. Refer to
Creating a New Travel Voucher and Creating a New Travel Authorization (Travel Orders) for more details.
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The Rates Menu

The Rates menu is used to view and search for the per diem, mileage rates and meal deductions used to calculate allowances.

Rates: Refer to Browsing Per Diem Rates for more details.

States/Countries: Clicking the States/Countries command displays a table containing all the state and country codes and three-letter
identifiers used by Travel Manager to locate per diem destinations.

Mileage: Clicking the Mileage command displays a table containing the rates for use in reimbursing a traveler for the use of his/her pri-
vate vehicle (for example, automobile, motorcycle, airplane).

M&IE Distributions: M&IE distributions represent the amount subtracted from the M&IE amount when meals are provided at no expense
to the traveler. This function is not normally used by FAA organizations.

The Reports Menu

Travel Manager reports allow you to monitor and control travel activity with your organization, for a traveler or a group of travelers. Re-
ports summarize information on all of the documents that have been entered, imported or restored into the Travel Manager database.
Each report lets you to specify criteria to limit the documents that are included. Travel Manager provides three types of reports:

Travel Ledger

The Travel Ledger is designed to be a “receivables” ledger. It will display or print all travel advances and vouchers for a traveler
where the authorization number has not been marked “reconciled.” A “reconciled” document is a document for which reim-
bursement has been received. Clicking the Travel Ledger command or button displays the Travel Ledger window.

Enter the social security number of the traveler. For a list of travel-
ers, press [F6], double-click or select the lookup button.

In the Start Date and End Date fields, enter the earliest and latest
departure dates to include on the report. Leaving the date field
blank implies no date restriction.

The Travel Ledger window.

Enter the electronic processing status code of vouchers to be included in the report. Leaving the Voucher Status field blank indicates that
all status codes should be included.

To view the report on the screen, click the Preview button. Click Print to obtain a hard copy of the report.

A sample Travel Ledger.
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The Travel Ledger displays or prints the advance outstanding, the amount claimed, and the amount due the traveler or government for a
particular traveler’s documents. All documents with the same authorization number are displayed together. Outstanding cash advance
balances are displayed for each authorization number. You may not directly modify the values displayed or printed by the Travel Ledger
report. To change the amounts displayed by a travel ledger, you must edit the documents included in the report.

Clicking the Reconcile button will display a list of all authorization numbers associated with the selected traveler. Once reimbursement is
complete, you can designate that the authorization number has been reconciled so that it will no longer be displayed or printed in a Travel
Ledger report. To reconcile an authorization number, highlight each document and select Resolve. The document will then be set to Yes
(reconcile). The reconciliation function can be used to track documents that still have amounts due or some other “open issue.”

Accounting Summary

Selecting Accounting Summary provides a report of expense category subtotals within each accounting class code. The Accounting
Summary report includes accounting information for one document type only (travel authorization, travel voucher, local voucher). Date
and status selection criteria are also available for this type of report. For example, you may set the criteria to display local vouchers that
have the status of Approved vouchers, where the traveler departed during the month of June 1998 and expenses were charged to a spe-
cific budget. Clicking the Accounting Summary command displays the Accounting Summary Report window.

Click in the appropriate radio button to indicate the document type
for the report. Then enter the Start and End dates for the report in
the Date Range fields. These indicate the earliest and last depar-
ture dates to include on the report. Leaving the date fields blank
implies no date restriction.

Use the drop-down menu at center to select the Organization to be
included in the report. Leaving this field blank will include all or-
ganizations. Do the same for the electronic processing Status of
the documents to be included. Leaving this field blank indicates
that all status codes should be included.

Clicking the in Detail Report check box will include a breakdown of
costs by expense category in the report. The Accounting Summary Report window.

You may select a specific accounting code by entering its exact name in the Account Label field. When you select a code, the Account-
ing Classification fields are automatically filled with the corresponding elements. Leaving the Label and Classification fields blank indi-
cates a selection of ‘all’. For a list of available codes, press [F6], double-click or select the lookup button (+). You may also select a
specific code by entering in its exact elements; or you may also include many codes by using wild card characters. The standard DOS
wild cards -- asterisk (*) and question mark (?) -- are supported.

To view the report on the screen, click the Preview button. To print a hardcopy of the report, select the Print button.

A sample Accounting Report with expense category detail.
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Document Summary

Selecting Document Summary lets you generate reports based on five different criteria: Traveler, Account Classification, TA Number,
Location and Trip Purpose. Clicking these commands displays a Document Summary Report window, which has identical fields and
procedures to those shown for the top half of the Accounting Summary Report window shown on the previous page.

The Traveler Document Summary pro-
vides a one-line summary for each
authorization or voucher number for
each traveler.

A sample Document Summary Report for one traveler.

The Account Classification Document
Summary provides a line-by-line table
of each authorization or voucher num-
ber for each traveler.

A sample Document Summary Report for one account classification.



Doc Prep Toolbar and Menus

Travel Manager Complete 37

The TA Number Document Summary
provides a line-by-line table of each
document prepared by the Travel Man-
ager user.

A sample Document Summary Report listed by TA Numbers..

The Location Document Summary
provides a one-line summary of
documents for a given per diem loca-
tion.

A sample Document Summary Report for one location.

The Trip Purpose Document Summary
provides a one-line entry for each trip
purpose by document and subtotals all
documents specifying the same trip
purpose.

A sample Document Summary Report for a specific trip purpose.
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The Setup Menu

The Setup menu lets you reset your password (if logins are enabled), reset your electronic signature, delegate your signing authority (if
signature/routing is enabled), and set up your system preferences.

Set Password and Set Signature

If your organization uses Travel Manager’s login security feature,
you will be prompted to set your password the very first time you
log into the system. You may reset your password or electronic
signature any time using the Set Password or Set Signature com-
mands, respectively. The Set Password or Set Signature window
appears.

The window and its fields are the same for either of the com-
mands. Enter your desired new password or signature in the mid-
dle field, re-enter it at bottom for confirmation and click the OK
button when finished.

The Set Password window.

Delegate Authority
Refer to Electronic Processing for details.

User Preferences

The User Preferences function lets each user specify a time format (AM/PM or 24
Hour). When you prepare an authorization or voucher, you enter all times in the
format specified in the Preferences window.

The Preferences window.

Save Settings on Exit

User Preferences is designed to let each user on a multi-user system have a different setup. This allows users to make changes to their
setup without affecting the general setup of the software. Save Settings on Exit should be enabled (a check mark will be displayed next
to it). This will save the option settings that are in memory when any user exits from Travel Manager. If logins are enabled, each user with
a valid User ID and password can customize his or her Travel Manager setup using this feature.

The Utilities Menu

Functions on this Menu are not ordinarily activated for use by employees in most FAA organizations. For more information regarding this
menu, contact your organization's Travel Manager System Administrator.

The Modules Menu

The Modules menu is used to access other Travel Manager modules. Depending on your security setup, you may not have access rights
to some or all of the modules.
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The Help Menu

Full documentation for this product is provided online through the Help menu. It uses a plug-in application, Adobe Acrobat Reader 3.0
freeware, to display the information. This plug-in must be installed by you or your organization's Travel Manager System Administrator.

Contents

Clicking the Contents command launches Acrobat and displays the cover page shown below.

The Adobe Acrobat Reader 3.0 window and table of contents for Travel Manager's online help.

To navigate through the text, click your mouse pointer on the colored lines. The program operates similar to an Internet web browser.

Search for Help On

Selecting Search for Help On displays a dialog box for locating information on a specific
topic.

Type the desired text string in the box labeled Find Results Containing Text, and click the
Search button. When your results appear, click on the listings to jump your reader to that
portion of the documentation. The Adobe Acrobat Search window.

Federal Travel Regulations

Clicking this command opens a standard Microsoft Win-
dows help utility browser containing the FTRs.

About Travel Manager

Selecting About Travel Manager will display information
on the current version of Travel Manager, serial number,
and copyright.

A standard Windows help window containing the Federal Travel Regs.
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SPECIAL SECTION

Function Keys and KeystrokesFunction Keys and Keystrokes
 The following table explains the features assigned to certain keys in Travel Manager for Windows.

KEYSTROKE FUNCTION

[Enter] Used to make a selection.

[F1] Displays the Travel Manager Help Contents Page.

Esc Aborts or cancels an action or function.

Home Moves the cursor to the beginning of the text string for editing.

End Moves the cursor to the end of the text string for editing.

Insert Allows you to insert characters in an existing text string.

Delete Allows you to delete the character to the right of the cursor in an existing text string.

Backspace Allows you to the delete character to the left of the cursor in an existing text string.

Alt+Letter Selects the option specified by a name containing an underlined letter.  For example, [Alt+F] selects
File from the menu bar.

[Tab] Moves the cursor from field to field.

[Shift] + [Tab] Moves the cursor from field to field in reverse direction.

[F6] or +  button Lists available choices for the field.

99 Text boxes with an underscored down arrow will drop-down a list of options.  Click on the down arrow
button to display the list.

Arrow keys Allow you to select functions from a menu or items in a selection list.  Arrow keys also move the cur-
sor in the direction of the arrow when you are editing text.
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SPECIAL SECTION

The Cost Options UtilityThe Cost Options Utility

The Cost Options window.

You can use the Options button in several screens of a Travel Voucher to view or change the following attributes of an entry:

Reimbursable—To change the reimbursability of the cost field, check the Reimbursable box to mark the cost as a reimbursable ex-
pense. If no check is in the Reimbursable box, the cost is not reimbursable to the traveler. This box is usually checked as the default
setting.

Expense Category—The category in which expenses will be subtotaled.

Payment Method—The payment method used for the expense.

Vendor—The vendor used for the expense. The vendor list provides an easy way to track expenditures by vendor.

Foreign Currency Calculator—The foreign currency calculator converts foreign currency to US dollars.

To convert foreign currency to US dollars:
1. From any cost field, select Options.
2. In the Foreign Currency field, enter the amount of the foreign currency.
3. In the Exchange Rate field and press [Tab], enter the exchange rate.
4. Travel Manager displays the converted cost in the Expense Cost field at the top of the Cost Options dialog box.
5. If this amount appears to be incorrect, try using the exchange rate displayed at the bottom of the Cost Options dialog box.
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SPECIAL SECTION

When Travel Manager CrashesWhen Travel Manager Crashes
The dialog box depicted below can be one of the most frustrating occurrences a user will encounter:

The "Single User Mode" error message. The directory path shown on your computer may differ slightly.

Don't despair. It's a problem you can remedy. Begin by clicking the OK button to get rid of that annoying box.

What has happened, most likely, is that for whatever reason, Travel Manager was closed improperly. The application may have crashed,
something else might have hung on your computer, maybe there was a power outage. The problem is, Travel Manager doesn't know that
you aren't using it anymore -- and in the message above, it is refusing to let you in "twice." You need to tell Travel Manager that you actu-
ally aren't using it now.

Travel Manager is usually configured to run from your Local Area Network (LAN). The setup varies somewhat from one FAA organization
to another. But typically, the program runs from one location, and your user files and directories are stored in another location. This sec-
ond location could be on your computer's hard drive, or sometimes it might be in your personal directory on the LAN. You may need to
check with the Travel Manager System Administrator for your organization.

If the client files are in fact located on your hard disk, it (and some other things) will probably be in a directory called C:\TM70. Take a
look by using your Windows 95/Windows 98 Explorer, or the My Computer icon, or your Windows 3.1 File Manager.

The TM70 directory on drive C as viewed using Windows 98's My Computer window.

Inside the TM70 directory will be some other folders, including one called DB.

The C:\TM70\DB directory viewed using Windows 98 Explorer.

The DB directory will contain a file called TRAVEL.LK. This file is the "offender," because it contains a notation that indicates
to Travel Manager that the application is still in use, when we know this is not the case. You need to delete this file. Be
careful -- the directory may contain at least three other files beginning with "travel," including one called TRAVEL.LG. Don't
delete these.

Once you have deleted TRAVEL.LK, run Travel Manager again. You may receive a dialog box containing a set of "recovery" statements.
Just click the OK button and proceed with using the program again.
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Numbering MemoNumbering Memo

Subject: ACTION:  Standard Travel Document Numbering
Conventions

Date:

From: Associate Administrator for Administration
Reply to
Attn. of: Deborah M. Daniels:

(202) 267-9008
FAX:(202) 267-5271

To: FAA Management Board

This memorandum provides policy for numbering of all employee travel docu-
ments.  The standard numbering structure, as described in attachment 1, is
designed to facilitate processing and tracking of travel authorizations and
vouchers.  All offices should begin using the standard document numbering
format for travel that occurs on or after October 1.

The standard numbering structure will become increasingly important as we im-
plement the National Automated Travel System (NATS).  The NATS uses Travel
Manager off-the-shelf software, an automated interface to the Departmental
Accounting and Financial Information System, and a tracking system to help
travelers determine the status of their reimbursements.  The system is being
beta tested at the William J. Hughes Technical Center and will be deployed in
regions, centers, and headquarters during FY-98.  This system will provide
efficient processing of travel documents, easier tracking of documents, and
faster reimbursement of employee travel expenses.

The contact point for questions about the standard document numbering conven-
tions and NATS is Deborah Daniels, ABA-320, at (202) 267-9008.

Edwin A. Verburg

Attachment

cc:  ABA-320/ABA-300/ABA-1/AAD-1
File:  2720.25I
WP:  C:\My Documents\natsnum

ABA-320:ddaniels:dd:(202) 267-9008:8/6/97
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Travel Document Number Structure and NATSTravel Document Number Structure and NATS

The following describes the numbering structure that will be required for all travel documents in the FAA beginning with travel that occurs
on October 1, 1997. The numbering structure is required for the transition to the National Automated Travel System (NATS).  The NATS
combines Gelco Travel Manager off-the-shelf software with an in-house developed document tracking module and automated interface to
the Departmental Accounting and Financial Information System (DAFIS). The system will provide for more efficient processing and track-
ing of travel documents and quicker reimbursement of employee travel expenses. The numbering structure is primarily based on cost
centers and establishes unique document numbers for each travel authorization.

The numbering structure applies to manually prepared documents, as well as those prepared using Travel Manager software. Each cost
center should establish a log of travel authorization numbers, as a number may be used only once. In the near future the log will be auto-
mated nationally using the same numbering conventions.

Single Trip Authorizations
The travel authorization number consists of 12 positions. The first two positions are the last two digits of the fiscal year (FY). The next six
positions indicate the cost center. Some regions use four-digit cost center codes; in those cases, the number must include two zeros
following the cost center code to fill the six places. The next three positions show a sequential number which makes each authorization
unique for a given cost center (e.g., first authorization of the FY might be 001, second authorization 002, etc.). The last position desig-
nates the type of travel authorization; this character is needed for the NATS interface with DAFIS.

If the travel authorized is a single trip other than centrally funded training, make the last position of the document number the letter “S”.  If
the travel authorization is for centrally funded training, make the last position of the document number the letter ”T”. (Note - When using a
“T” as the last character of the document number, the accounting classification code for that document must begin with the letter “A,”
which indicates the travel is funded by the Aeronautical Center.)

Limited Open Authorizations (LOA)
There are two methods for numbering LOA travel. This depends on whether or not the office wants an obligation established in DAFIS
based on the travel authorization document.  If the office wants the obligation amount to be recorded in DAFIS based on the travel authori-
zation document (referred to as “LOA-Cost” type of document in Travel Manager software), the travel authorization number will be the
structured the same as the single trip authorization number except the twelfth character will the letter “L”. Specifically, the LOA number is
12 positions long consisting of the FY in the first two positions, the cost center in the next six positions, a sequential number in the next
three positions, and the letter “L” as the last position.

Some offices prefer to show obligations for LOA travel authorizations on a monthly or quarterly basis and therefore do not want an obli-
gation established in DAFIS based on the travel authorization document. In such cases, the office should use the “LOA-no cost” type of
document in Travel Manager software. The document number is structured the same as LOA-Cost type of document described above
except the 12th character will be omitted (i.e., the document number will be only 11 positions in length).

Travel Advances
The SF 1038, Advance of Funds Application and Account does not require a document number. However, the SF 1038 must show the
appropriate travel authorization number in block 9a of that form. Employees may use Travel Manager to generate a travel advance request
form.  Although FAA regions and centers will be moving toward paperless travel processing for other temporary duty and local travel
documents, travel advances will continue to be manually processed as described in the Travel Manual, FAA Order 1500.14a and will not
be entered into NATS.

Permanent Change of Station (PCS)
PCS travel authorizations and vouchers will be processed in NATS as a future enhancement. To prepare for this, offices should begin
numbering their PCS travel authorizations using the same pattern as the single trip authorization except the twelfth character will be the
letter “P”.

Amended Travel Authorizations
Travel Manager will automatically save these documents under the same number as the original travel authorization followed by a hyphen
and a sequential number. Offices should enter that same number in the “Travel Authorization Number” field in Travel Manager. Manually
prepared amendments to travel authorizations should also use that numbering convention.
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Canceled Travel Authorizations
To cancel a travel authorization, offices must use the same document number as the original document except the last position must be
the letter “C”. If the original document number included a letter in the last position, omit that letter and replace it with the letter “C”. This
will cause NATS to properly generate a transaction to reverse the obligation of funds that was established by the original authorization.

Temporary Duty and PCS Vouchers
Manually prepared temporary duty travel and PCS vouchers do not require a voucher number. Although there is no required voucher
numbering convention for temporary duty travel vouchers that are prepared in Travel Manager software, a suggested numbering format is
described in the section below.

However, temporary duty and PCS vouchers must show the correct travel authorization number in the “Authorization Number” field.  The
NATS system uses the temporary duty authorization number to create the entries needed to adjust the obligation previously recorded and
process payment of the voucher through the DAFIS.

Local Travel Expense Vouchers
The SF-1164, Claim for Reimbursement for Expenditures on Official Business, is used for local travel and other miscellaneous employee
expenses. These documents will have a 15-position document number. The first nine positions show the claimant’s social security num-
ber and the next six positions show the date that the SF-1164 is prepared.

Suggested Numbering Conventions for Vouchers in Travel Manager
Travelers, who prepare their vouchers with Travel Manager software, must save each voucher under a unique number. Although there are
no required numbering conventions for vouchers other than those submitted on an SF-1164, it is suggested that travelers use the same
number as they used for the associated travel authorization when they save the documents in Travel Manager software. This will make it
easier for travelers and their managers to identify the related authorizations and vouchers in the Travel Manager data base. When multiple
vouchers will be filed for a given authorization, such as LOA and long-term temporary duty travel, it is suggested the traveler save the
vouchers in Travel Manager using the travel authorization number followed by the date of the voucher.

Examples of Travel Document Numbers
For the following examples, assume the fiscal year of the travel is FY-98, the cost center is 1234, and the employee’s SSN is 222-22-
2222. Also, assume the following: the single trip authorization was the first travel authorization issued by that cost center for FY-98; the
single trip for centralized training authorization was second; the LOA-Cost authorization was third; the LOA-No Cost authorization was
fourth, the PCS authorization was fifth; and October 1, 1997, is the date that the employee created the local voucher (SF-1164). The last
item in the list below is an example of document numbering conventions for amendment of the single trip authorization.

Trip Type Sample Document Number Numbering Formula
Single Trip Authorization 98123400001S Two digits of FY + six-position cost center + three-position se-

quential number + “S” for single trip.
Centralized Training Authorization 98123400002T Two digits of FY + six-position cost center + three-position se-

quential number + “T” for centrally-funded training.
LOA (Obligating Authorization) 98123400003L Two digits of FY + six-position cost center + three-position se-

quential number + “L.”
LOA (Non-Obligating Authorization) 98123400004 Two digits of FY + six-position cost center + three-position se-

quential number.
PCS Authorization 98123400005P Two digits of FY + six-position cost center + three-position se-

quential number + “P”.
Local Voucher (SF-1164) 222222222100197 Travelers SSN + 6-position date that document is prepared.
Canceled Travel Authorization 98123400001C Same as the document that is being canceled except replace any

letter that was used in the last position with the letter “C”.
Amended Travel Authorization 98123400001S-1 (first amendment)
Amended Travel Authorization 98123400001S-2 (second amendment)

Same as the document that is being amended + hyphen and se-
quential number.
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Addendum to Numbering MemoAddendum to Numbering Memo

Subject: ACTION:  Addendum - Standard Travel Document
Numbers

Date: September 22, 1997

From: Manager, ABA-320
Reply to
Attn. of: Deborah M. Daniels:

(202) 267-9008
FAX:(202) 267-5271

To: Managers, Operating Accounting Offices

This provides a temporary amendment to the standard travel docu-
ment numbering conventions, which were defined in the September
15, 1997, memorandum from the Associate Administrator for Admin-
istrator to the FAA Management Board.  This amendment applies to
New England, Eastern, Central, Great Lakes, Western-Pacific, and
Northwest Mountain Regions.

Offices in the stated regions must continue to prefix the travel
document number with the region code indicator as they have done
in the past.  Therefore, the travel document number will be one
position longer than stated in the original memorandum.  Offices
in the stated regions will need to continue to prefix the stan-
dard travel document number with the region code until NATS is
installed in each region.

If you have any questions about this amendment, please contact
Deborah Daniels at (202)267-9008.

Martin N. Finkelstein

cc:  ABA-320
File:  NATS
WP:  \Document2

ABA-320:ddaniels:dd:(202) 267-9008:9/22/97
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Automation Learning Center/FAA Northwest Mountain Region
COURSE EVALUATION
Information Technology strives to maintain a high quality learning environment.  In order to achieve this goal, we value
the feedback of our students.  Please take a minute to complete this anonymous evaluation.
Your candid responses will aid us in monitoring and improving our service to you.

Course Title Travel Manager Complete  Instructor_________________________________ Date ______________________
High      Low

1. Organization/preparedness of Instructor's presentation.......................................10 9 8 7 6 5 4 3 2 1
2. Instructor's presentation of the material was understandable ..............................10 9 8 7 6 5 4 3 2 1
3. Instructor's knowledge of course content...........................................................10 9 8 7 6 5 4 3 2 1
4. Instructor's ability to keep class focused on curriculum......................................10 9 8 7 6 5 4 3 2 1
5. Instructor's ability to answer questions ..............................................................10 9 8 7 6 5 4 3 2 1
6. Instructor’s use of training equipment, visual aids and/or materials .....................10 9 8 7 6 5 4 3 2 1
7. Instructor emphasized and reviewed key points..................................................10 9 8 7 6 5 4 3 2 1
8. Instructor’s interaction with students .................................................................10 9 8 7 6 5 4 3 2 1
9. My overall impression of the course ..................................................................10 9 8 7 6 5 4 3 2 1
10.  My likeliness to recommend this course to others ...........................................10 9 8 7 6 5 4 3 2 1

Overall course length (circle one):      too long        just right       too short               Pace of class (circle one): too fast just right       too slow

Please offer any other comments about the Instructor:

__________________________________________________________________________________________________

__________________________________________________________________________________________________

How effective was the course in meeting your objectives? Why?

__________________________________________________________________________________________________

__________________________________________________________________________________________________

What portion of the workshop material was most beneficial? What information did you find to be most applicable or useful?

__________________________________________________________________________________________________

Did any particular segment of the course not get sufficient attention, or too much attention? What was lacking or overdone?

__________________________________________________________________________________________________

In your opinion, what other types of information  would you have liked to see covered in the course?

__________________________________________________________________________________________________

Describe the workshop's effect in improving your effectiveness and/or efficiency as it relates to the FAA mission.

__________________________________________________________________________________________________

__________________________________________________________________________________________________

What other general comments or suggestions for improvement do you have regarding this service? Continue on the back if necessary.

__________________________________________________________________________________________________
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